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TIPS Carlson Software 2009 Installation Instructions

Getting Started

® Before starting the installation process, you will need the following:

TIPS Carlson Software 2009 CD.

Serial number, hosts file, and environment variable information provided with the
distribution.

The end user must have administrative privileges on the workstation for the software to
function properly.

In order to avoid errors, the end user’s account should be logged in while performing the
installation.

Approximately 10 minutes for installation on each user machine.
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General Overview

® The CD includes a built-in browser that provides access to the following:

CD Distribution Information

Installation Instructions

Carlson Software 2009 Installation

Carlson Software 2009 Manual

Carlson Software 2009 Help files

Summary of Carlson Software 2009 Improvements
Adobe Acrobat Reader Installation

In order to properly install the Carlson Software 2009, you must do the following:

1.

N

Install and launch the Autodesk software that Carlson Software 2009 will be used with prior
to installing the Carlson product. If Raster Design will be loaded on the user machine, it is
recommended that it be installed and run once also.

Use the instructions below to install Carlson Software 20009.

Ensure that the environment variable LSHOST and the HOSTS file are set according to the
documentation provided with the distribution. Note that if a previous version of TIPS
Carlson or SurvCADD software was installed, the required settings will have already been
applied.

Launch Carlson Software 2009 in order to complete registration and automatically check for
and install current updates. Current updates can be accessed directly at
http://update.carlsonsw.com/updates.php.

Restore the AutoCAD “Express’ (i.e., Express Tools) and ‘Image’ (i.e., Raster Design)
menu dropdowns.

If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Buckmaster at (276)
523-0042 x13 or TBUCKMASTER@OSMRE.GOV.



9/15/2008 Carlson Software 2009 Page 2 of 15
Insert the TIPS Carlson Software 2009 CD

o Insert the disk labeled Carlson Software 2009. If the TIPS CD browser does not start
automatically, browse to and double click on the CD-ROM drive with the volume label
‘“TIPSCARLSON2009’; if that fails to launch the browser, navigate to the root directory of the
CD drive and double click ‘Autorun.exe’.
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TIPSCARLSON2009 (D:)

e The TIPS CD browser will open.
e Click (i.e., single left button mouse click) on Install Carlson 2009 to begin program installation.

OSM TIPS Carlson 2009 Installation Disk &|

Click on Each "Button” to Initiate the Conesponding Action,

Mote that Acrobat Reader must be inztalled to dizplay the documents,

Dizplay Infarmation About This CO-ROM

About This CD Distribution.

Dizplay the 0SM TIPS Installation [nstructions
for Carlzon 2009 software,

; ; Install Carlson 2009 zoftware
L Instal Carson 2005 2] 2 [Full Install Yersion 0E-02-2008)

Installation Instuctions

Dizplay the Carlson 2009 Manual
Carlzon 2009 Manual | [Version 041 7-2008]
Carlsan 2009 Help Diizplay the Carlzon 2009 Help dislogue.

Diizplay the summary of Carlzon 2009 software

Carlzon 2009 Improvements h
Improvemnents.

Inztall Adobe Acrobat Feader.

Inztall Acrobat Reader Version 7.0.5]

Finizh
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The Carlson 2009 installation process will initialize...
Click Next to continue with the installation.

Carlson Setup

Welcome to the InstallShield Wizard for Carlson 2009

N Yo G

InstallShizld < Back ext Cancel

Carlson Setup

Licenze Agreement

the fo

License Agreement
Copyright 1992-2008 Carlzon Software Al Rights Reserved
CAUTION! READ THIS WOTICE BEFORE USING SOFTWARE

Fleaze read the following Software License Agreement before uzsing thiz
software package. Using this software indicates that you have accepted
itz terms and conditions.

Carlson 2009
EMD-USER LICENSE AGREEMENT FOR CARLSOM SOFTWARE

IMPORTAMT-READ CAREFULLY: Thiz Carlson Software End-User License
Agreement ["EULA" iz a legal agreement between you [either an

individual or a single ertity) and Carlzon Software, Inc for the

Carlzon 2009 zoftware accomparying this ELILA, which includes computer

JrastallShield < Back Yes No
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Select the version of CAD software that you want to use with Carlson 2009 (in this case, click on
the circle next to AutoCAD / AutoCAD Map 2009).
Click Next to continue.

Carlson Setup

Select CAD version

InstallShieid < Back h Hest> [ Cancel

—

Enter the Serial number provided with the distribution.
Click Next to continue.

Carlson Setup

Get Senal Number

InstallShield < Back h HNeut » ,- Cancel
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Verify the install path. The default ‘C:\Program Files\Carlson2009_ACADO09’ is recommended.
Use Browse to change the default location if desired.
Click Next to continue.

Carlson Setup

Choose Destination Location

InstatlShild « Back Cangel

Choose the preferred Setup Type:

‘Complete Install’ copies all files to the user computer.

‘Remote Install” copies some files to the user computer and some to a network server.
The ‘Complete Install” option is recommended (The ‘Remote Install’ option has not been tested
and is not supported by TIPS.).
Click Next to continue.

Carlson Setup

Setup Type
ect the s

p you prefer.

Fiemate install
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Verify the Carlson work directory. This is where the program will store drawing and data files
by default. The default *C:\Carlson Projects’ is recommended.

Use Browse to change the default location if desired.
Click Next to continue.

Carlson Setup

Select Work Directory

Select a directory to be used by default > drawings and data files

Cancel

Verify the project settings directory. The default ‘C:\Carlson Projects\Settings’ is recommended.
Use Browse to change the default location if desired.
Click Next to continue.

Carlson Setup

Select Settings Directory

Browsze...

Installshigld < Back Cancel
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Review the information in this dialog box to ensure that all settings are as desired.
o If changes are needed, click Back to revert to the appropriate screen(s) and revise as necessary.
Click Next to continue.

Carlson Setup

Start Copying Fi
Res

Modules selected: Basic Carlson 2009
Survey
Civil
Geology
Hpdrology
B azic Mining
Underground Mining
Surface Mining
Field
Point Cloud
Matural Regrade
Inztall type: Full install
Carlzon 2009 Directony: C:\Program Files\Carlzon2009_ACADDS
Frogram Directorny: C:%\Program FileshCarlson2003_aCADOILSPY
whark, Directary: C:ACarlzan Projectsh
Exec Directony: C:\Program Files\Carlzon2009_ACADDSWEXECS

Cancel

Insratlshield

o If a previous version of Carlson software is installed, you will see the following window.

e Click *Yes’ (recommended) if the user wants program settings from the previous version applied
to Carlson Software 2009.

e Click *No’ if the user does not want the settings copied.

Installation has located user setting from previous version of Carlson/SurvCADD,
- at C\Documents and SettingsitmastallApplication DatayCarlson SoftwarelCarlsonZ008R 17,1, Would vou like ko copy vour
settings From that wersion of Carlson/SurwCADD over to Carlson 20097

e The installation will progress with files being copied...

[nztalling
C:hCALSPASCADPROJ.DCL

T l

[nztalling
C:hCarlzon Projects\Settingzhcarlzon.fld

T |

Inztalling
C:h U AEREChCarlzon2009. chm

(ARRARRRRARRR RN AR AR AR
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Select the version of the Autodesk product that you would like to start with Carlson 2009 (in this
case, AutoCAD Map 3D 2009). This is dependent on what version of Autodesk software is
installed and was specified in the step at the top of page 4.

Click Next to continue.

Carlson Setup

Select AutoCAD

InstaliGtield < Back t Mest > > Cancel
i

Note Updates and Support options.
Click Next to continue.

Carlson Setup

Support and Updates information

Lpport options:

Installshiel < Back Cancel
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Click Finish to complete the installation.

Carlson Setup

Inztall5 hield Wizard Complete

Double «

Irstal iGheld < Back Caricel

Click Finish to close the TIPS CD browser.

OSM TIPS Carlson 2009 Installation Disk

X

Click on Each "Button' to Initiate the Coresponding &ction,

Mote that Acrobat Reader must be installed to dizplay the documents,

Dizplay Information About This CO-ROM

About This CO Distribution.

Display the 05M TIPS Installation [nstructions

Installation [nstructions for Coarleor 2009 softvoare.

[Full Inztall Wersion 08-08-2008]).

Digplay the Carlzon 2009 kanual
[Verzion 04-17-2008).

Dizplay the Carlzon 2009 Help dialogue.

Carlzon 2009 Manual

| e Erarian S | Install Carlzon 2009 zoftware
Carlson 2009 Help |

ﬁ"l Carlzon 2009 Improvements | Dizplay the summary of Carlzon 2009 zoftware
/ improvements.

Install dcrobat Beadsr | ::‘r:fstal_l Ad%:nlaeE.-;-\cmbat Reader.
ersion 7.0.5].

oo | Cenn D

Before launching Carlson Software 2009, you must set the environment variable LSHOST and
the HOSTS file according to the information provided with the TIPS distribution. Note that if
a previous version of TIPS Carlson or SurvCADD software was installed, the required settings
will have already been applied.
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Launch Carlson 2009 / Program Updates / Registration

e Launch Carlson Software 2009 from one of the Carlson desktop shortcuts or from the Start
Menu.

or

W ord »
H—I Cal 3 Carlson 2008 For AutoCAD Map 30 2008
B Carlson 2009 Movies Ml Carlsc h AutoCAD May 09 »
AukoCAD Map 30 2 e

£

.
ﬁg Paint
L
. Carlson Mining 2009 with AutoCAD Map 30 2009
Launch Gongle Esrt) s -y aturl Regrade 2009 with ALESCAD Map 3D 2009

-; Carlson Point Cloud 2009 with AutoCAD Map 30 2009

Fu 2009 w toCAD Map 3D 2009

EA carlson Field 2009 with AutoCAD Map 30 2009
-‘ Catlson Hydro 2009 with AutoCAD Map 30 2009

Sl TS ‘ =) Carlson Projects
M Catlson Survey 2009 with AutoCaD Map 30 2009
@ Check for Carlson 2009 Updates
"":" start &l O @ Reset User Profile

e The program will automatically check for main program updates upon the first run (via internet
connection).

e If updates are identified during this process, it is recommended that they be installed to ensure

that the most current features are available to users. Simply follow the screen instructions to
accomplish this.

e If no updates are available (as shown below), click Exit.

Carlson Software Update Wizard

Connecting to Carlzon update zerver...

Mo update available,

Click Ewit button,

Mo update iz available.

Click Exit ta finish. .

[~ Mever check again Options
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AutoCAD Map 2009 will proceed to open.

If the AutoCAD Map 3D New Features Workshop box appears, select the circle next to ‘Maybe
later’ to enable the user to be reminded of the New Features Workshop on the next program
launch (The New Features Workshop can also be accessed at any time from the Map “Help’
menu.).

Click OK to continue.

AutoCAD

Map 3D

The Carlson 2009 “Startup Wizard’ window will open as a default. Click Exit to close the
window and continue with the Carlson automatic registration process.

Note: The “Startup Wizard” will not appear if the user had previously altered this setting and the
installation included copying the settings (see the middle of page 7, above). In that case the
program will proceed directly to the Carlson registration.

Drawing1.dwg

Inquiry Settings Paints Window S 2tline AreafLayout

G2 hnans ARua2 8 J@% o

Startup Wizand

Recent Files

Presview

DD 0RBONTODE ™

Open Recent File

> [ 9 1

[ Skip Startup wizard Mest Time

(e ) D |
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o If the Carlson registration process does not see the serial number entered during installation, the
‘Enter Carlson Software Serial Number’ window will appear. If it does, enter the serial number
provided with the distribution, and click on OK.

< Enter Carlson Software Serial Humber.

Registration information for Carlzon Software ig either miszing or incorect,

Pleasze enter the zenal number supplied to you with the product.

MOTE: Onwindows MT, 2000 or =P Pro, Adminigtrator rights are required

to perform thiz step. Contact your local administratar if in doubt.
B e

s—

—
r, e .

e The Carlson registration process will complete.
e Click OK to continue.

Carlson Software Message

Regiztration Completed

e Carlson 2009 will open to the module selected to initiate the program (in this case ‘Carlson Civil
2009%).

ivil 2009 with Aute

& dSbdm s ARTET L pRasel B

o Next, verify that Carlson 2009 is set to open to the ‘AutoCAD Map Classic’ menu.
e Select the *Settings’ menu dropdown and click on Carlson Configure...

File  Edit  Wiew  Draw  Inguid tings ints 30 Data

Trnlhars
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e Click General Settings...

Carlson Software 2009

Drawing Setup... |
[ Project/Data Folders... | Startup Dptiors.. |
[ Survey Settings... | Surface Settings... |
| Section-Profile Setfings.. | [ Hydology Settings.. |
[ Mine Nate Optioris... | Miring Settings... |
| Takeoff/SiteNetSettings.. | [ Localization Optiors.. |
| Eat [ Hep ][ Load | [ Saves |

o Verify / select AutoCAD Map Classic as the setting for ‘AutoCAD Menu.’

e Click OK to continue.

General Settings

General Object Linking

Coordinate File Format

|se Startup Wizard

[ Generate Report Log

Save Drawing INI Files

lghare Zera Elevs

[ Use Sauth Azimuth

Use Dview Twist Angle

Set DIMSCALE to Drawing Scale
[[] 5et PDSIZE to Symbol Size
SetINSUNITS to Unitless

00001 0000

Remove Arcs Offset

Coordinate Feport Order

D ate Format

Report Viewer

Carlzon Repart Wiewer

AutoCAD Mernu

[ Link Paints with CRD File
[ Link Linewwark, with Points

(®) Carlzon Numeric Only

(O Carlzon Alphanumeric

O Acces: 97

[ Link Labels with Linewark

[ Link Linewark, with Centerlines
Group Paoint Entities

[ Mairtain CRD Histary File

(O C and G Mumeric Only
(O C and G Alphanumeric

Databasze Format O Simplicity ZAK.

® Aceess 2000 O LDT Faints. mdb

Digitizer Settings
Uze Mouze

Cancel Help
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X

e Click Exit to close Carlson 2009 configuration.

General Settings. ..

Crrawing Setup...

J |

Project/Data Folders...

J |

Startup Optionz. ..

Survey Sethings...

J |

Surface Settings...

Section-Profile Settings. .

J |

Mine Mote Options...

J |

bining Settings...

T akeaff/SiteM et Settings...

J |

Localization Options. .

Load

]

]

]

Hydralogy Settings... |
]

]

Savehs |

J | J |
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Restore AutoCAD Express Tools and / or Raster Design Menus

e Launching Carlson 2009 using the program “Start’ menu or desktop shortcuts may set AutoCAD
with Carlson 2009 to open minus the ‘Express’ (i.e., Express Tools) and / or ‘Image’ (i.e., Raster
Design’) dropdown menus.

e Once the menus are restored per the steps below, the settings will be preserved. The ‘Express’
and ‘Image’ menus will be included no matter what program shortcuts or *Start’menu item is
used to open AutoCAD Map / Carlson 2009.

e Note: The ‘Express’ and ‘Image’ menus may not appear in the same position or order as shown
in the screen capture below.

Carlson 2009 with AutoCAD - [CRD: MONE] Drawing1. dwg

Eile Edit Hiew Insert Farmat Toals Draw Dimension Podify it il s
hEed ohesGEg XDDhES - CAGQ EEE SE
RMmé&SYPam /7 ARNE 0 A5 OYm0

e To restore the “Express’ menu, simply enter ‘expresstools’ on the command line (i.e., type
‘expresstools’ and press the enter/return key.).

l & oL E U Y TIULdl LAOYY SIS

Enter command nate:
Corgrand: COMMANDLINE

e Go to the “File’ menu dropdown and click Exit to close the program.
To restore the ‘Image’ menu dropdown, open Carlson 2009 with AutoCAD using the Raster
Design desktop shortcut or the Raster Design Start Menu.

Autodesk AukoCAD Map 30 2009

AllPrograms Cyhersky @ AutoCAD Raster Design 2009 @, Portable License Uity

Del Accessories _& Autodesk Design Review 2009 & /2 Raster Design 2009 on AutaCAD Map 30 2009

ESRI

Galena os... G APPSIAULD. .

The “Image’ menu dropdown should be restored.
e Go to the “File’ menu dropdown and click Exit to close the program.
This completes the installation of Carlson 2009.
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e The latest program updates can be accessed / downloaded at any time by visiting
http://update.carlsonsw.com/updates.php and selecting Show Files for “‘Carlson
Survey/Civil/Mining/Takeoff for CAD’ and the appropriate CAD product version.

Carlson Software is dedicated to
providing the finest software to Land

Surveyors, Civil Engineers, Mining
Engineers, and Land Development

Professionals

Select product yvou are looking for | Carlson Survey/Civil/Mining/Takeoff for CAD ~

Select product version 2009 for AutoCAD/IntelliCAD + |m

e ———
Carlson 2009 download page

running Carlson 2009. If you are not, then do not download any updates from this page.

/A
|@ Before downloading any updates, go to Help-»About Carlson and verify that you are
A/,

If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Buckmaster at (276) 523-0042
x13 or TBUCKMASTER@OSMRE.GOV.



